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Dear All,
We are pleased to inform you about the upcoming product release of the updated CHCNAV
CoPre desktop SW V2.7.6 The main history of updates are listed below.

1. CoPre-2.7.6-20231228

Bug Fixed in CoPre 2.7.5
 Fixed the issue that the strip adjustment did not work properly during AA10 data

processing.
 Fixed the error of the CS Manager when converting geodetic coordinates to projection

coordinates using four params.
 Fixed the issue of the CS Manager file recognition garbled characters which is non-utf-8

encoded with latitude and longitude symbol (° ' ").
 Fixed the issue that the AU10 V2 data cannot be copied.

2. CoPre-2.7.5-20231219

New Functions and Improvements
 Added the display of the current project coordinate system in the coordinate system

settings interface. When creating a new task, the coordinate system settings will not
default to retaining the settings from the previous task.

 Added the new function of coloring the point cloud with DOM. Users only need to input
DOM and projected coordinate point clouds from the same location to coloring the point
cloud with DOM.
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 Support enabling ” Circle Noise Filter” settings without using MTA to solve the issue of
excessive noise in point cloud processing of partial data.
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 Support the thickness optimization of data collected by AA10, and the average thickness
of the optimized point cloud is within 2cm.
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 Optimized the memory usage of the adjustment algorithm. Solved the problem of
software crash caused by excessive data.
 Added the function of smoothing light and color to optimize color differences of colored
point clouds in vehicle-mounted mode.
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 Added advanced Settings during Pos processing, to solve the problem that the accuracy
of POS is not enough in some cases.
 Add Accel/Gyros Scale: Enabling this setting can solve the errors calculated by the IMU.
 Atmospheric Estimation: If the base station is far from the survey area, it is recommended

to enable this setting to improve pos accuracy.

 Added English and Russian versions to the trial registration page's verification code
SMS/email. The software will send the verification code in the language currently used in the
CoPre.
 Optimized the interface, coordinate conversion algorithm logic, and operational steps of

the coordinate conversion tool.
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 Support importing batch point or point cloud files for conversion.

 Support to choose different ellipsoids for the projected coordinate conversion.

Bug Fixed in CoPre 2.7.4

 Fixed the issue in AA10 data where specular reflection noise occurred in areas with
direct sunlight.
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 Fixed the issue where meters were still displayed in some functions when the unit was
selected feet during data processing .

 Fixed the issue where the software sometimes reported “POS interpolation failed” error
when processing data in batches.

 Fixed the issue of incorrect display of base station coordinates near -0° in the southern
hemisphere .

 Fixed the issue where when importing a range line with the same starting and ending
points, the software failed to recognize the closure and could not control the modeling
range.

 Fixed the issue that the trajectory was seriously deformed due to the long base line of
the base station and only single frequency signal during some data calculation.

 Fixed the issue of severe trajectory distortion during POS processing of certain data due
to long baseline and single-frequency signals in the base station.

 Fixed the issue of failure in adjusting vehicle-mounted data with longer mileage.

 Fixed the issue where POS accuracy was missing when there are multiple instances of
9999 in the base station coordinates.

 Fixed the issue where POS algorithm filtered the beginning of the static part, leading to a
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failure in calculating the camera POS during photo processing.

 Fixed the issue of software crashing when processing partially corrupted AU20+AP5 raw
data .

3. CoPre-2.7.4-20231024

New Functions and Improvements
 Carrier options now include the M350 drone, support copying data collected by the

M350 drone.

 Added the trial registration function where users enter their phone number or email,
along with the corresponding verification code, to get one month of trial permission.
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 Optimized the adjustment algorithm for vehicle-mounted single project data, and
increase efficiency by 1-2 times.

Bug Fixed in CoPre 2.7.4

 Fixed the bug of precision loss when inputting coordinate system transformation
parameters with more than 6 significant digits during coordinate system setup.

 Fixed the bug where only one type of carrier was displayed in the carrier drop-down box
on the copy tool's main interface.

 When the device serial number (SN) doesn't match, the software will prompt whether to
continue copying ; previously, data couldn't be copied.

 Fixed the issue of software crashing when importing certain KML files.
 Fixed the bug where it was not possible to input negative values for the rotation angle in

TGO four parameters during coordinate system setup.
 Fixed the bug of software crashing during coloring due to missing photos in the raw data.
 Solved the issue that the data shift becomes larger after the adjustment in partial

vehicle-mounted single project data.
 Fixed the bug of distortion in the AA10 point cloud processing of some flight routes as

below.

4. CoPre-2.7.3-20230909

New Functions and Improvements

 Combined the foundation function and modeling function of CoPre into a single
installation package.

 Added vector node in task management, and added import/export functions for DXF and
SHP format vectors in vector management.
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Description
The Vector Management Function includes importing, exporting, removing, and drawing
capabilities. The import feature supports importing KML, SHP, or DXF files to assist in selecting
tracks and modeling areas of interest. The export feature allows for exporting files in SHP or DXF
formats based on the selected trajectories.

Vector Import steps
（1）Click on "Home -> Vector -> Import";
（2）After selecting a KML, SHP, or DXF file, click "OK," and the chosen file will be loaded into the
track view and 3D view;
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Vector Export Steps
There are two ways to export vectors: exporting from loaded trajectories and exporting from
selected vector nodes.
Method 1
Exporting from Loaded Trajectories: Choose the original project trajectories for export.
（1）Display the original project trajectories in the trajectory view, select the trajectories you
want to export, and click on "Home -> Vector -> Export."
（2）Click on "Export by trajectory", choose the file format (SHP or KML), and then select the
output directory to initiate the export.

Method 2
Exporting from Selected Vector Nodes: Select a vector node for export.
（1）In task management, select the vector, then click "Home -> Vector -> Export".
（2）Click on "Export by vector", choose the file format (SHP or DXF), and then select the output
directory to initiate the export.

 Added vector node in task management, and added vector drawing function.

Description
This function is used to draw SHP format vectors in the 3D view.
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Steps
（1）Click on "Home-> Vector -> Draw";
（2）In the 3D view, use the left mouse button to click and draw. Right-click to access a menu for
cancel and redrawing. Click "End" to conclude the drawing .

Menu Description
End(Ctrl+E): The vector's starting point and endpoint automatically connect to form a closed
vector, completing the vector drawing.
Cancel(Ctrl+Z): Go back to the previous drawing step.
RedrawCtrl+Y): Proceed to the next drawing step.
Exit(ESC): Exit vector drawing.
 Optimized the coordinate system settings interface , and solved lag issues in the

coordinate system configuration.

 Added the point cloud clipping function, which allows for point cloud clipping to remove
noise.
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Description
This function is used for point cloud clipping to remove noise.
Steps
（1）Click "3D View -> " to activate the clipping command, and the clipping mode window will
pop up.

Icon Description

Rectangle box selection: Select point cloud data by dragging the mouse to create a rectangular
selection box.

Polygon box selection: Select point cloud data by clicking the mouse to draw a polygonal
selection box.

Remove Selection: Remove selected point cloud data by dragging the mouse to create a

rectangular selection box.

Interior clipping: Keep the point cloud within the selection box
Exterior clipping: Keep the point cloud outside the selection box.
Clear：Undo the selection or clipping.
Save；After saving the clipped point cloud data, overwrite the original point cloud data.

（2）Select the rectangle (or polygon) box selection tool, draw a rectangle (or polygon) on the
point cloud, and then click on " Interior clipping " (or " Exterior clipping ").
Point cloud before clipping:

Point cloud selected by Box:
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interior clipping:

Exterior clipping:
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（3） Click "Save," then click "Confirm" in the pop-up window. When the progress bar reaches
100%, it indicates that the point cloud clipping is complete. After clipping, the point cloud data in
the project will be overwritten and automatically reloaded into the 3D view.
 Added measurement tool, which includes point measurement, density measurement,

distance measurement, and area measurement.

1.Point Measurement
Description
This function is used to measure the coordinates, RGB, intensity, time, echo, scan angle, scan
direction, and point source ID of a point cloud.
Steps

（ 1 ） Click "3D View -> " to activate the measurement command. Select "Point

Measurement" from the pop-up menu to open the point measurement window.
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（2）Click on a point , and the measurement information for that point will then appear.

Note: Point measurement is only effective for measuring the point cloud.
2.Density Measurement
Description
This function is used to measure the density of the point cloud.
Steps

（ 1 ） Click "3D View -> " to activate the measurement command. Select "Density

Measurement" from the pop-up menu to open the density measurement window.

（2）Set the length, then click on the point cloud you want to measure. The point cloud density
information within the red box will be displayed in the window.
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Note: Density measurement is only effective for measuring the point cloud.
3.Line Measurement
Description
This function is used to measure distance.
Steps

（ 1 ） Click "3D View -> " to activate the measurement command. Select "Distance

Measurement" from the pop-up menu to open the distance measurement window.

（2）Measure the distance on the point cloud by clicking with the mouse to start drawing a line
and double-clicking to finish the line segment.
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4.Area Measurement
Description
This function is used to measure area.
Steps

Step 1: Click "3D View -> " to activate the measurement command, then select "Area

Measurement" from the pop-up menu.

（2）Click to select points and double-click to finish drawing a closed region on the point cloud.
The region will be highlighted, and the area will be displayed.
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 Added coordinate origin and tile origin settings, both of which can be chosen as adaptive
or customized according to requirements.

 Added the function to set a region for reconstruction.

Selecting 'All Area' models the entire point cloud or images, while choosing 'Select Area' models
only the point cloud or images within the vector-defined range.
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 Point clouds now can be colored by number of echoes, echo number, project, and user
can show/hide color bars.

 Improved the rendering colors and precision rendering threshold display in the trajectory
view for better visual effects.

 Support MTA solution for AU20 1000kHz vehicle-mounted data.
 Support data copy for self-developed cameras on P60, and other cameras on P330Pro.
 Added Google Maps as a map source in the trajectory view.

Bug Fixed in CoPre 2.7.3

 Fixed the issue where the progress bar during POS calculation with slam optimization
would get stuck at 90% in certain cases.

 Fixed the issue of requiring entering reversed values when setting the lever arm value for
user-defined carrier.

 Fixed the issue of abnormal point cloud processing when users selected a local
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coordinate system .
 Fixed the issue of being unable to copy more than 10,000 photos at once.
 Fixed the issue of software not recognizing camera sensor size when importing external

image files with filenames longer than 20 characters.
 Fixed the issue of inconsistency between KML time and point cloud time records in the

result folder.
 Fixed the issue of the progress bar getting stuck during modeling in certain cases.
 Fixed the issue of CoPre crashing during adjustment when importing GGF models.

5. CoPre-2.7.2-20230809

New Functions and Improvements

 Support processing data collected by P60 UAV.

 Optimized the point cloud processing result of the data collected by Alpha3D-L Dual.
 Added Fixed Rate and Pass Rate to Image POS calculation result when P330Pro or P60

equipped with C5/C30 .

Bug Fixed in CoPre 2.7.2

 Fixed the bug that there is no las file name in the exported kml file.
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 Fixed the bug that there is no GLO satellite info in the POS report.
 Fixed the bug that the quality check of Alpha3D-L Dual data failed.
 Fixed the bug that failed to process the Alpha3D-L Dual data when raw laser data is

segmented.
 Fixed the bug of data distortion after adjustment of point cloud data under tunnels and

viaducts.
 Fixed the bug that POS processing failed when P330Pro equipped with C5/C30.
 Fixed the bug that the Loosely Coupled Mode configuration for vehicle-mounted POS

computation was not taking effect.

6. CoPre-2.7.1-20230716

New Functions and Improvements

 Added the function of using SLAM and INS tightly coupled solution to improve POS
accuracy, can repair POS jumping.

Click Tools→POS optimize, or check the POS optimization function when processing POS:
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 When copying AP5 data, distinguish between backpack mode and vehicle mode.
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 Optimized the POS processing algorithm, added settings for loosely coupled and tightly
coupled algorithms.
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Bug Fixed in CoPre 2.7.1
 Fixed the bug that incomplete generation of power lines from data collected by AU20

caused by MTA algorithm.
 Fixed the bug that CoPre occasionally prompts "calibration parameters do not match the

device" during data processing.

7. CoPre-2.7.0-20230531

New Functions and Improvements

1.1 Point Cloud Modeling

 Point cloud modeling is 30% faster than image modeling.
 The requirement of lateral overlap rate in point cloud modeling is reduced, which can

improve the operation efficiency.

Steps：

（ 1） Select Modeling Function at AT node, which will pop up a window that let you set

parameters.

（2）Select Lidar as data source.

（3）Set the relevant parameters in the pop-up window, click OK, and the software will use the

point cloud results for modeling.
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1.2 Optimize the point cloud coloring algorithm , improve the efficiency of

colorization by 50%.

1.3 The user manual is in chm format for easy browsing.

1.4 Updated the data copy process of partial devices

For current AU20, AlphaPano and AA10 units, please manually select the mount

carrier before data copy.
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Bug Fixed in CoPre 2.7.0
 Fixed the bug of incorrect display of fixed/float status in POS accuracy curve.
 Fixed the bug of the original data could not be solved completely due to the repeated

laser acquisition.
 Fixed the bug of Post file could not be output properly when copying M300+C30 data.

8. CoPre-2.6.1-20230427

New Functions and Improvements
 Added two new modes to the refinement function, just refine the position of point

cloud, won't reprocess POS.
1) Mode 3：Refine point cloud (base on near control point error),the point cloud refinement
value is calculated by interpolating the error of adjacent control points, used for the scenario
with many control points, block or urban road.
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2) Mode 4：Refine point cloud (point cloud overall offset), the whole point cloud is rotated
and offset.,used for the scenario where the relative position of the control point is offset
from the point cloud. When using this algorithm, ensure that the control points cover the
survey area and distribute evenly.

 Added the function of data quality check, can detect data loss and jump of Lidar and IMU,
and detect whether the images are missed.
Step:

1) Click ”Tools→Data Check”, the data check window will automatically pop up;
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2) Click “Import” button to import the data to be checked;

3) Check the items to be checked, including Lidar data, camera data and IMU data,then
click ”Check”button.
4) Wait until the progress bar reaches 100%, click can open the “Source Data Quality
Report”, as follow:
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 Added the function of point cloud thickness optimization.
description:
Only used for data from AA450（AA450Pro）、Alpha3D、VA3 and AU10, can reduce the

thickness of point cloud.
Step:

1) Click ”Tools→Point Cloud Optimize”, the Point Cloud Optimize window will automatically
pop up;
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2) Set Coordinate Type and Carrier Type.
3) Import the point cloud that needs thickness optimization, can import las, laz, and codata
format.
4) Set thickness optimization parameters, including Grid Sampling,Grid Size (m),Max Thick
(m),Merge Files and File Formart.
5) Set Output Directory.
6) Click Start to start thickness optimization，wait until the progress bar reaches 100%, can
check the result in the PointCloudRefine folder of the Output Directory path, as follow:

 Added the function of adjust selected time areas when adjusting vehicle-mounted
data.When checked Adjust Selected Time Areas, only point clouds within the time
range of the selected trajectory are adjusted.
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 Added the function of project configuration in project management;

Description：

Used for data processing for P330Pro with 3rd party camera.

Step:

1) Click ”Project Management→Config Project” in the main view, the Config Project window
will automatically pop up;

2) Import base file, GNSS file, IMU file, click “Preprocess” to check whether the number of
photos and trigger are the same.
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3) Import CP file and image data.

4) Select the output directory, click “Start” to convert data, wait until the progress bar to
reach 100%.
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 Added data processing function for AA10 Lidar system;
 Added software parameter setting section in user's manual;
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 Deleted the function of preprocessing.
 Optimized the MTA algorithm for AU20 data to solve the data noise problem;

 Optimized data processing function for AA1400 data, mainly for power line data;

 Added the function of outputting error message during aerotriangulation, DOM

CoPre2.6.0

CoPre2.6.0

CoPre2.6.1

CoPre2.6.1
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generation, and modeling;
 Optimized POS accuracy curve chart display of float/ fixed ambiguity status;

 Optimized the logic of organizing pictures;
When organizing pictures in CoPre 2.6.0，copy and rename photos to the result path.
When organizing pictures in CoPre 2.6.1，rename photos to the original project path.

 Optimized point cloud coloring algorithm for Airborne data;

CoPre2.6.0
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 Optimized the POS accuracy of partial data is not high.

Bug Fixed in CoPre 2.6.1
 Fixed the bug of abnormal data conversion in I83 receiver.
 Fixed the bug of data distortion and incomplete process of partial AA450 data.
 Fixed the bug that CoPre failed to delete historical base stations.
 Fixed the bug of abnormal point cloud coordinate conversion.

CoPre2.6.0 CoPre2.6.1

CoPre2.6.1
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9. CoPre-2.6.0-20221231

New Functions and Improvements
 Added the function of configuring multiple servers into a cluster to do Image-Based

Modeling;
Steps:
(1) Select a AT node, click “Model”

(2) Select the “cluster mode” and click “Settings” to pop up “Node Management”
dialog box. CoPre will automatically read the machines on which the cluster service is
enabled in the LAN, and the Node IP/Group ID is displayed on the left. Select the Node
IP/Group ID that needs to be the child node of the engineering task, click “Add” to join
the node, and click “Yes” after the configuration is finished

Notes:
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1. When using cluster mode, the raw data and tasks should be stored on the server
2. When using cluster mode, need to ensure that each child node can successfully

access the server and have read and write permissions
3. Host node (computer for the new task) to participate in modeling, also need to

open the cluster service and add the node IP

 Added the function of POS accuracy setting in three-dimensional triangulation process;
Added the function of POS accuracy setting in three-dimensional triangulation process,
can set the plane and height accuracy to improve the accuracy

 Added the function of remodel failed tiles on the model node;
Click ”ReModel” on the model node.
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 Added the function of cancel building model;

 Added the function of generating POS report;
POS report can be used to check the quality of POS accuracy. CoPre SW can generate POS
report in two places:
(1) After POS processing, you can manually select “Generate POS Report” on the
original project. After the POS report being generated successfully, can right-click “Open
POS Report” on the original project to open the POS report
(2) After generating result, the POS report is automatically generated, can right-click
“Open POS Report” on the original project to open the POS report
The POS report is as follows:
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Note: the file path of POS report is under the original project “\GPS\Post”.
 Added the function of generating result report;

Check “Generate Results Report” when generating the results, a result report will be
generated. The result report includes four parts: project summary, process overview,
picture overview and point cloud overview. The result report is as follows:
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 Added the function of automatic trajectory selection for UAV data;
Right-click on the original project to display trajectory, and the software will
automatically select the straight trajectory of the UAV data
Note: only straight trajectory longer than 25 sec will be selected.
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 Added Multi-hue rainbow options for height and intensity coloring;

 Added the function of displaying relative height;
After the POS trajectory being displayed in the trajectory view, “CTRL+ left mouse button”
to select the POS trajectory point, and the “POS detail” window will pop up, can check
the relative height to the first POS trajectory point
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 Added the function of setting point cloud sampling rate when generating results;
When generating results, can set the sampling rate through the drop-down box at the
sampling rate, and the sampling rate can be set to 25%, 50%, 75%, 100%. The default
sampling rate is 100%, which means no sampling
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 Added the function of displaying trajectory in the 3D view;

 Added the function of displaying rotation center in 3D view;

 Added the function of showing / hiding base stations in trajectory view;
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 POS processing supports batch setting of base station parameters;
When multiple sets of raw project data use the same base station, set the base station
coordinates once and click “Batch settings” to complete the base station coordinate
settings for all projects

 After picking out the correspondence point, you can use the left, right, up, and down
keys of the keyboard to fine-tune the position;

 Optimized license management for modeling module;
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Bug Fixes
 Fixed the bug that the POS trajectory failed to display after POS processing in wizard

mode;
 Fixed the bug of failing to set LAS version when doing thickness optimization for AA450

data;
 Fixed the bug of inconsistent point cloud between preprocess and result of preprocess;

 Fixed the bug that the point cloud cannot be displayed according to the selected
trajectory after thickness optimization;
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 Fixed the bug that POS processing will crash in WIN10-LTSC system;

10. CoPre-2.5.2-20221117

New Functions and Improvements
 Added the function of sorting the control points;

Click the table header to sort the control points.
(1) Click “Name (ID)”, the control points will be sorted in order by the names of the
control points, as shown below:

(2) Click “Type”, the control points will be sorted by “Check Point” and “Refine Point”,
as shown below:

(3) Click “Refine Type”, the control points will be sorted by “2D Point” , ”3D Point” and
“Height Point”, as shown below:
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(4) Click “Project Name”, the control points will be sorted by the name of the project,
as shown below:

Bug Fixes
 Fixed the bug that Codata format data converted in CoPre 2.4 failed to color by flight in

CoPre 2.5.1;

 Fixed the bug that failed to enter the focal length manually when importing images
collected by third-party devices;
When importing images collected by third-party devices, if the focal length info is not
recorded in the exif, clients need to enter the focal length manually in CoPre. CoPre 2.5.1
failed to enter the focal length manually, and CoPre 2.5.2 fixed the bug

CoPre2.5.1 CoPre2.5.2
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 Fixed the bug that check points are indistinguishable from matched points;
Both check points and matched points are purple in CoPre 2.5.1, so it is difficult to
distinguish them. The check points are purple, and the matched points are blue in CoPre
2.5.2

 Solved the problem that when the single flight is long the adjustment result will be not
good;
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11. CoPre-2.5.1-20221017

 Support the import of images collected by the third-party equipment to generate DOM
and reconstruction;

 Optimized the adjustment algorithm of single flight, and improve the data processing
efficiency by 2-5 times;

 Optimized the refinement algorithm, and improve the data processing efficiency by 2
times;

 Optimized CoData format for compatibility with CoProcess;
 Optimized the stumbling problem during point cloud browsing;
 Optimized the output of abnormal information when processing POS;
 Fixed the bug that sometimes there is a missing trajectory in POS processing;
 Solved data processing problem of AA1400;
 Fixed the bug that an abnormal prompt will pop up when adding new control points;
 Fixed the bug that data could not be processed and displayed when the PosT output

frequency more than 200 Hz;
 Fixed the bug that when the mission time is too long, may fail to download the cloud

base station data;

12. CoPre-2.4.6-20220914

 Added the function that support data copy of C5 21 mm camera;

13. CoPre-2.5.0-beta-20220902

 Added the 3D reconstruction function, including aerial triangulation, generating DOM,
modeling functions;
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 Adjusted the layout of the software interface;
 Set the coordinate system when creating a new task;
 When processing POS, the coordinates of the base station can use the local coordinate

system;
 Added the data copy function of C5;
 Optimized the information output window;
 Delete the repetitive POS of images when organizing pictures;
 Fixed the bug that during POS processing “authorization expiration” info will pop up;
 Fixed the bug that “Degree. Minute Second” format file was incorrectly read in

Coordinate Conversion Tool;
 Fixed the bug that the POS processing fails caused by too many base stations;
 Fixed the bug that the antenna height of some HCN files was incorrectly read;
 Fixed the bug of UAV data stop at 50% during POS processing;

14. CoPre-2.4.5-20220821

 Added function of AU20 data MTA processing;
 Added function of Riegl laser data MTA processing;
 Optimized image matching logic of Data Copy Tools;
 Added the SD card security eject function after the data copy is complete;
 Fixed data missing issues of SDC solution;
 Fixed image organizing issues of C30;
 Fixed crash issues when multiple laser files exist in AA1400/AA2400 project;

15. CoPre-2.4.4-20220722

 Turn on the scale factor of IMU;

16. CoPre-2.4.3-20220621

 Added function of C30 + P530/P330 data copy and data process;
 Support to convert las file in Coordinate Conversion tool;
 Support to display the location of control points used in Coordinate Conversion tool;
 Fixed bug with the CoPre would crash in some cases;
 Fixed bug with AA1400 multi-prism data process is abnormal;
 Fixed bug with abnormal display according to the flight;
 Fixed bug with RXP data was deleted when SDC data was added;
 Fixed bug with I50 receiver data model read error;
 Fixed bug with laser data matching errors on some devices when copy data;
 Fixed bug with the abnormal display of drive on some devices when copy data;
 Fixed bug with Data Copy tool window text color display error;
 Fixed bug with E57 format point cloud content error;
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17. CoPre-2.4.2-20220430

 Added function of downloading cloud base station;
 Added function of displaying base station location in trajectory view;
 Optimized software interface style;
 Adjusted the software interface of the Data Copy tool;
 Support data copy for C30 and C6 devices;
 The coordinate transformation tool supports transformation of point clouds;
 Support displaying control point distribution when parameter calculation in Coordinate

conversion tool;
 DOM in OSGA format can be imported;
 Fixed some translation errors;
 Fixed displaying bug when the coloring point cloud RGB value was (0, 0, 0);

18. CoPre-2.4.1-20220402

 Added laser data processing function of AA1400/AA2400;
 Fixed a bug that SW will crash when processing a single flight data;

19. CoPre-2.4.0-20220316

 Added DOM quick generation and DOM browsing functions;
 Added the function to refine both Position and Attitude;
 Added Geodetic coordinate system, Earth-fixed coordinate system and Space

rectangular coordinate system;
 KML import supports displaying attribute information;
 Added authorization expiration notification function;
 Added plane filtering function;
 Added trajectory jump check and repair function;
 Added the function of coloring by flight;
 Support to load the solved point cloud during data processing;
 Support loading point clouds of refining and point clouds of adjustment simultaneously;
 Optimized GCPS import function;
 The import project and import control point locate the last path by default;
 Fixed a bug that point cloud solved using 7 parameters does not match the map;
 Fixed a bug of incorrect names of taskbar window;
 Fixed a bug of point cloud browsing with AMD processor;
 Fixed a bug where CoPre would prompt expired authorization in case of data problems;
 Fixed a bug where western hemisphere data projection coordinate value was 0;
 Fixed a bug of 4 parameter calculation error in Coordinate Conversion Tool;
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20. CoPre-2.3.2-20211223
 Fixed the bug of coordinate conversion error when the central meridian is 0;
 Fixed the bug of multi laser point could loading;
 Fixed bug with invalid LAS / LAZ echo in version 1.4;
 Fixed the bug of UAV data coloring error;
 Fixed bug with wrong separator of onboard orbit template;
 Fixed the bug that the point cloud cannot be loaded by the POSC of the GPS1980

system;
 Fixed the bug of point cloud coordinate error when some data are converted with

ellipsoid;

21. CoPre-2.3.1-20211127

 Fixed bug of central meridian reading error during adjustment;
 Fixed the bug that the scanning angle and echo times of RIEGL data calculate error;
 Fixed the bug of incorrect information recording in the northern and southern

hemispheres of the result point cloud coordinate system header file;
 Fixed the bug that point clouds display abnormal of section analysis;
 Fixed the bug that automatic slicing display abnormal in adjustment;

22. CoPre-2.3.0-20211117

 Added the function of Task Wizard;
 The result data supports the height matching;
 Support SLAM data processing;
 Automatic slicing adds automatic check layering function;
 Added POS accuracy curve;
 Result point cloud adds the scan angle information;
 Added mask function of vehicle data coloring;
 Result point cloud adds the coordinate system information;
 Added images Mask tool;
 Optimized software interface and some data processing logic;
 Optimized the function of point select, the nearest control point will be automatically

matched after selecting points;
 Unified the section style of vertical slice and automatic slice;
 Unified Chinese and English coordinate system setting page;
 Optimized the echo information of result point cloud;
 Optimized data processing stability of AA450;
 Optimized the window of import project;
 Optimized the size of log files;
 Fixed the bug that the Data Copy tool crashes after matching data;
 Fixed the bug that the Data Copy tool matches incorrectly project data;
 Fixed the bug of point cloud data color rendering;
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 Fixed the bug that some camera data match incorrectly of the Data Copy tool;
 Fixed some bugs caused after formatting of the Data Copy tool;
 Fixed the bug of wrong picture naming;
 Fixed the bug with the wrong time of adding SDC data;
 Fixed the bug of HCN conversion failure with multi project POS solving;
 Fixed the bug of software crash when refine under network path;

23. CoPre-2.2.3-20210907

 Fixed the bug of software crash when generating refine Codata;
 Fixed bug that refine Codata cannot generate;
 Fixed the bug that the threshold from GCP to pos is wrong under foot project;
 Fixed the bug of data time reading error in some RINEX 3.02 data;
 Fixed some bugs with incorrect prompt information;
 Fixed the bug of wrong point time of three-point fitting circle center;

24. CoPre-2.2.2-20210827

 Supported new device protocol resolution;
 Picture solving supports exception data processing;
 Fixed some bugs in Russian system;
 Fixed Hesai laser echo bug;

25. CoPre-2.2.1-20210804

 Fixed the bug of partial data solution failure of CoPOS;
 Fixed the bug of inconsistent center display of point cloud in 2D view and 3D view;
 Fixed the bug that only display GCP in the current pos range is abnormal of result

trajectory；
 Fixed several bugs in accuracy report of Refine;
 Fixed the bug with invalid intensity render when switching result point cloud;
 Fixed the bug that when central longitude displayed as zero during the Western

Hemisphere data adjustment;
 Fixed the bug of multiple camera data matching in the Copy Data tool, only one camera

is successfully matched;
 Optimization: Data Copy tool checks the remaining disk space before copying data;
 Copy Data tool adds the function of opening the output directory;
 Added function of auto-slicing ;
 Added stop function;
 Added MTA function;
 Rearranged some icons on the software page;
 Optimized processing efficiency of AA450 data and fix the problem of data solution

failure;
 Fixed the problem of partial POS solution failure;
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 Fixed the bug that Chinese version of the coordinate system settings error;

26. CoPre-2.0.9.102-20210528
 Added the function of unit selection when importing control points, and support the

degree, minute and second format;
 Unified the English coordinate system with LS7;
 Fixed the bug that multi project POS solution doesn't work at the same time;
 Fixed the bug that adjustment and refine cannot generate colored point cloud without

movie picture;
 Fixed the bug that generated DD file with wrong format;
 Fixed the bug of base station coordinate display error in POST file header of Western

Hemisphere and southern hemisphere;

27. CoPre-2.0.9.101-20210514

 The base station data of POS solving supports HCN format (HCN to RINEX 3.02);
 Fixed the bug that the original project can't display the point cloud without photo data;
 Optimized the photo missing detection function;
 Optimized the compatibility of Data Copy tool;

28. CoPre-2.0.9-20210416

 Added the unit of US feet and international feet;
 Added the Data Copy tool;
 Added accuracy evaluation items of CoNAV: satellite number, PDOP, forward and

backward solution accuracy;
 Added the function of result accuracy verification;
 Fixed the bug of license reading error;

29. CoPre-2.0.8-20210329

 Optimized file directory structure;
 Optimized CPU utilization in data solving;
 Added the function of result project import;
 Added the laser solution of Hesai;
 Fixed the bug that the point cloud cannot be solved with the noise filtering selected;
 Fixed bug that the color LAS cannot be generate after refine process;

30. CoPre-2.0.7.104-20210305

 Fixed the BUG that laser type identification is invalid of point cloud optimization;
 Fixed the BUG of single camera photo size reading error;
 Improved algorithm of point cloud optimization;
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31. CoPre-2.0.7.103-20210303

 Fixed some translation problems;
 Fixed the segmentation error of LAS when generating results;

32. CoPre-2.0.7.102-20210303

 Fixed the problem of incorrect display of the collection time in the viewing project;
 Fixed that when reading post files, the files with the suffix of "post" are not recognized;
 Fixed the problem that fail to color point cloud with the error of "The picture result is

not generated by the modified post/cp file, please check!" when generating result;
 Fixed the problem that the track view user selects the path, and the map does not take

effect;
 Fixed the problem that the solution is not complete when the photo is organized in

Ladybug multiple series Pgr;
 Fixed the problem of low real-time coloring efficiency of point cloud;
 Fixed the problem that the central meridian value of the coordinate system set last time

can’t be recorded;
 Fixed the problem that crash when removing the result project after switching the item;
 Select the point cloud list according to Codata and arrange in order of part number;
 The naming suffix format of the copy control point is changed to: _1, _2, _3, and it will

be automatically extended every time it is copied;
 Added the function of point cloud optimization;

33. CoPre-2.0.7.101-20210207

 Fixed the crash when importing seven parameters;
 Fixed that the base station in the selected base station coordinate database cannot be

solved;
 Fixed the failure of photo finishing and recognition test shooting;
 The Data Trans tool adds inertial navigation type setting items;
 The CoNav pos solution opens the estimated tropospheric model;

34. CoPre-2.0.7-20210118

New Functions and Improvements
 SolvedProjects supports the combined display of point cloud and panoramas;
 Added the selection and storage of base station data;
 Adjust and refine added the function of manually updating the camera pos;
 Added the function of GCP leakage inspection;
 One control point is shared for one project, and the matching point corresponds to the

project;
 The GCP can be displayed according to the project pos range;
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 Trajectory view and cloud point view added control GCP prefixes to facilitate viewing the
correction type of GCP;

 The camera pos displays the corresponding photo number in the trajectory view, and
supports the function of display and hiding;

 The Adjust provides the option of whether to generate Codata;
 Trajectory view time period and actual solution time period are displayed separately;
 In the trajectory view, Polygon Select and Measure support mouse double click to end;
 Trajectory view optimization: remove the gray outer border of the track point;
 Accuracy verification report adds average value and coordinate system attributes;
 The laser supports three echoes;
 Solved speed conversion: convert ENH to IMU;
 Added tooltip descriptions for parameter settings of Adjust and generated Result;
 The pos solve of CoNav speed is converted from the ENH to the carrier speed;

Bug Fixes
 Fixed issue when Latitude is set to 036:00:00.000000, the interface is displayed as

03:60:00:00.000000;
 Solved the problem of software crash when closing the project during pos solving;
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